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أساسيا
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 مقدمة :

كانت الصورة هي أول شيء لجأ إليه الإنسان البدائي للتعبير عن نفسه وعن أفكاره والدليل على ذلك أن 

أول الحررروا الاجائيررة فرري اللسررة الإنسررانية ا ولررى اتارريا شرركل وررور ا شررياء وال يررور والحيوانرراا 

 الشرق القديم.المحي ة بالإنسان ا ول في لساا 

وهكرريا أمررتمر الإنسرران فرري امررتاداي الصررورة فرري التعبيررر متررى تاررر فبررانون عمالقررة تميرر وا بقرردراا 

 ومااراا فائقة على التعبير بالصورة رمماً باليد.

ومتى أوائل القرن الثامن عشر كانت الصورة وما ت ال ترمم يدوياً بالقلم أو بالفرشاة على الورق وعلى 

الاشررب أو القمررا  أو ايرهررا ومعررروا بررأن  بررل اختررراو الصررورة الفوتوارافيررة كرران الحرروائو وألرروا  

الفبانون هم اليين يقومون بعمل التصوير اليدوي وذلك بالانتقال إلى مكان الحادث أو الابر ورمم وور 

تا ي ية له ، ثم تبقل إلى الاشب اليي يعرد للحفرر ثرم ال برر وعرفرت الصرحا تلرك ال ريقرة فري القررن 

اضي ميث كانت الصور على شكل خ وط تحفر في كتل خشبية ثم تسمر  فري الحبرر وت رسو علرى الم

الصفحاا إلى جانب المتن أو البص . وهيا ما كان يحدث في طباعة الكتب مبي اختراو آلة ال باعرة فري 

 القرن الاام .

آلرة التصروير ثرم لكن من الواضح أن هيه ال ريقة ب يئة وعقيمة ثم جاءا الثرورة الصرباعية واخترعرت 

أتررت الصررورة الفوتوارافيررة فأورربح مررن السررال علررى مررن لا يجيررد الرمررم أن يسررجل الوا ررر علررى لررو  

فوتوارافي وورة للأشياء تشبه الصورة في و ت  صرير وبتكراليا  ليلرة إذا مرا  رورن برا مر بمرا كران 

ث انقلابرا هامراً فري تراري   بل اختراو آلة التصوير ، ليلك كان اكتشراا آلرة التصروير مردثاً خ يرراً أمرد

 الصحافة.

وت ور فن التصوير الفوتوارافي وأوبحت له  واعرد وأمراليب فري التعبيرر واكتشرفت إمكانيراا آلرة فري 

تسجيل أو تكبيرر المبراتر ال بيعيرة ب ريقرة  رد تعجر  مروان الإنسران عرن إدراكارا ، فرأمكن علرى مربيل 

ر فيارا كران اجراجي بفعرل طلقرة ناريرة أو تصروير المثال تجميد الحوادث السريعة التصوير لحظة تتكسر

خلية نباتيرة بتركيرب آلرة تصروير فروق الميكرومركول ، لريلك امتلرت الصرورة الفوتوارافيرة مكانارا برين 

الفبون وأدواا التعبير وأوبحت تؤدى دوراً في الاتصال لا يقل أهمية عن دور الإعلاي ، بل ربما أكثر 

 تعبيراً من ا لفاظ أمياناً.

يوي نعيش ثانية في فترة من ال من يمكن أن ن لر  عليارا فتررة الصرور أو عصرر الصرورة ميرث تعرد وال

التصوير الفوتوارافي في أيامبا الحاضرة تاهرة من الظواهر الباراة في القرن الحادي والعشرين ومن 
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أساسيا
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الميكانيكية أي  البدياي أن هيه الظاهرة لم توجد إلا بوجود التصوير ال وئي وت وره ، مواء من البامية

 الفي يائية أي الكيميائية إضافة إلى المقدرة التي يجب أن يمتاا باا المصور .

ويجب أن نؤكد هبا أن الصورة الباجحة هي الصورة الواضحة المعبرة الحية التري تت لرب مرن المصرور 

 الصحفي أن يكون فباناً مرير الحركة ماضر البدياة .

ؤدي دورهرا ا مران فري توثير  الحردث ، أي تثبيرت الابرر فري ذهرن فبسير ذلك تعج  الصورة عرن أن تر

 المتلقي .
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  أهداف البرنامج التدريبي :

بوتيفرة  –إدارة التردريب  –يادا هيا البرنامج التدريبي الى تمكين العاملين فري إدارة المروارد البشررية 

ة لمسرتوى الجرداراا التري أخصائي بالدرجه الثالثة من أداء عملام الروتيفي علرى أكمرل وجره مرر مراعرا

 تراب باا الشركة من أجل تحقي  الاهداا المرجوة .

 في نااية الدورة التدريبية ميكون المتدرل  ادر على : 

 الإلماي بكيفية إعداد ومتابعة ميباريو التدريب. -1

 الإلماي بالقاعدة اليهبية في التصوير )التثليث(. -2

 معرفة ال رق الااوة في الإضاءة. -3

 خلا ياا التوثي  الفوتوارافي للبرامج التدريبية.الإلماي بأ -4

 معايير اختيار الصورة الجيدة. التعرا علي -5

 الإلماي بأم  التصوير بالتليفون المحمول "الموبايل". -6

 إعداد تقرير التوثي  الفوتوارافي لبرنامج تدريبي. -7
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 فهرس المحتويات :

 رقم الصفحة الموضوع م

 6 يق الفوتوغرافيالفصل الأول : أساسيات التوث 1

 8 إعداد ومتابعة ميباريو التدريب 2

 9 القواعد ا مامية في التصوير ) تكوين الصورة ( 3

 11  اعدة التثليث / القاعدة اليهبية في التصوير 4

 15 ال رق الااوة في الإضاءة )معرفة( 5

 17 أخلا ياا التوثي  الفوتوارافي للبرامج التدريبية 6

 18 ار الصورة الجيدةمعايير اختي 7

 20 الفصل الثاني : أساسيات التصوير بالموبايل 8

 29 إعداد تقرير التوثيق الفوتوغرافي:  الثالثالفصل  9

 30 تقرير التوثي  الفوتوارافي 10

 30 محتوياا تقرير التوثي  الفوتوارافي -أولًا : 11

 31 تقرير التوثي  الفوتوارافي خ واا إعداد  -ثانياً : 12

 38 إعداد المادة العلمية 13

 39 المراجع 14
 

 فهرس الأشكال :

رقم 
 الشكل

 رقم الصفحة اسم الشكل

 11  اعدة التثليث أو الثلث 1
 

 فهرس الجداول : 

رقم 
 الجدول

 رقم الصفحة عنوان الجدول

 8 ميباريو التدريب 1
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 الفصل الأول

التوثيق أساسيات 

 افيالفوتوغر
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 علي مجموعة من الأسئلةقبل البدء في عملية التوثيق الفوتوغرافي لابد أن تجيب 

 أولاا : ما الهدف من التوثيق الفوتوغرافي ؟

 ثانياا : ما هو الشيئ المراد توثيقه فوتوغرافياا ؟

 ثالثاا : أين تتم عملية التوثيق الفوتوغرافي ؟

 سجل إجابتك هنا ؟
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بعد إجابتك علي الأسئلة الساابقة ننتقال إلاي سايناريو الحادن )سايناريو البرناامج التادريبي 

بعااة أخصااائي التاادريب للساايناريو وتحديااد صااور المااراد توثيقااه فوتوغرافياااا( وكيفيااة متا

 الأحدان الواجب توثيقها فوتوغرافياا 

تعرفبا مابقاً في العديد من البرامج التدريبية إلي العملية التدريبية وكيفية إدارة ومتابعة البرامج التدريبيرة 

 ودور أخصائي التدريب في متابعة البرامج التدريبية ......

 سيناريو التدريب ومدي أهميته في التخطيط لعملية التوثيق الفوتوغرافيلذا نلقي الضوء علي 

  سيناريو البرنامج التدريبي -أولاً :

 ( يوضح ميباريو التدريب1جدول ر م )

 الهدف الموضوع اليوم م
إسلوب  الفترة

 التدريب

معينات و 

 أدوات التدريب

مكان 

 إلى من التدريب

 

 

       

        

        

        

 

 الخطوات الواجب اتباعها من أخصائي التدريب فور استلام سيناريو التدريب من المدرب :

درامة وتحليل السيباريو جيداً والتعرا علي أملول التدريب المستادي ومعيباا الخطوة الأولي : 

 التدريب وبال بر مكان التدريب وتحديد ا مداث الواجب توثيقاا فوتوارافياً.

  تجاي  مكان التدريب جيداً للحصول علي نتائج جيدة في عملية التوثي  الفوتوارافيالخطوة الثانية : 

 إعداداا ا ماكن المسلقة وترتيباا الجلون ) اعة التدريب / المسر  ..( . -

 تجاي  الإضائة المبامبة للتصوير. -

 الخطوة الثالثة : تجهيز المعدات اللازمة للتوثيق الفوتوغرافي 

 لكاميرا / الموبايل ا -

 معداا الإضائة ) فلا  / ومداا إضائة خارجية / عواك  ...( -

 مامل للكاميرا أو الموبايل. -
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 القواعد الأساسيه في التصوير ) تكوين الصورة (:

 

 

 

 

 

 الصورة البسي ة يمكباا أن تومي بأكثر مما تظاره في الحقيقة. البساطة: (1

 

مرن شرروط نجرا  ورورة مرا، هرو أن يكرون  : center of interestنقطة الجذب في الصاورة  (2

لتلك الصورة نق ة جيل، أي نق ة تثير الانتباه، وهيه البق رة  رد تكرون عبرارة عرن شريء أوعبصرر 

مسرري ر تببررى مولرره بقيررة العباوررر، واالبرراً مررا يكررون هرريا العبصررر كتلررة هامررة مسرري رة علررى بقيررة 

ي تمسك ببقية ا ج اء. ونق ة الجيل أو مركر  العباور، ونق ة الجيل هيه تعمل كوام ة العقد الت

 الجيل لا تعبي المرك  الابدمي للصورة. 
 

أو ومرر اا، فارري  ررد تتركرر  فرري أي جرر ء مررن الصررورة، وا الررب خررار  مرك هررا الابدمرري   ن 

الصورة التي لارا نق رة جريل وا عرة فري مرك هرا الابدمري أو ومر اا تصربح ورورة متماثلرة، ممرا 

ديباميكية، وفي أالب ا ميان تكون نق ة الجيل في وورة جيدة التأليا وا عة  يجعلاا جامدة واير

عبرد الثلررث أو الامرر  مرن أمررد أطرافاررا، مررن أي جارة مررن جارراا الصرورة، وتوجررد بعرر  الصررور 

الباجحة ميث نق ة الجيل فياا على مرك ها الابدمي، كمرا توجرد ورور ناجحرة نق رة الجريل فيارا 

ا.فبق ة الجيل هي العمود القروي فري مركر  الصرورة. يقرال أميانرا برأن وا عة في أ صى أمد أطرافا

وورة ا شياء ذاا البس  المتكرر ليست بحاجة إلى نق ة جيل وهو أمر وحيح ، لكن هريا البروو 

من الصور االبا ما لا تكون له أهمية جمالية، وإن وجردا فلري  الف رل فيارا للمصرور إنمرا لجمرال 

من ذلك فإن إدخال نق ة جيل فري هريا البروو مرن الصرور يحسإرباا إلرى  تصميم هيا البس ، وبالرام

 درجة لا بأن باا.

نقاط الجذب  البساطة

لصورةفي ا  

وجود خطوط 

 حركة معبرة

 القواعد الأساسية في التصوير
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 ةدرجة ثالث  –أخصائي تدريب 

 

 وجود خطوط حركة معبرة: (3

في الصورة الباجحة ، يجب أن تت افر كل الا وط وكل الكتل وكرل ترتيرب للعباورر لقيرادة العرين 

د المصرور لرربو نحو نق ة الجيل، ولعرل امرتعمال الا روط القويرة المعبررة هري أمسرن الومرائل بير

أج اء وورته ببع اا البع .  عبد امتعمال الا وط في بباء الحركة للصورة يجب عليك الانتباه 

لإيقاا تلك الا روط داخرل مسرامة الصرورة وعردي تركارا تفلرت خارجارا، وهبرا  طررق عردة لعمرل 

الصرورة وهكريا  ذلك، فإذا كانت الا وط فاتحة اللون فيمكبك تظليلاا تدريجياً مر ا ترابارا مرن مافرة

تقا العين عبدها ب ريقة ل يفة. كما يمكن القياي ببف  العملية مر الشرائح الملونة بوضر مادة تظلل 

 المب قة المراد إيقاا البظر عبدها . كما يمكبك امتعمال إطار طبيعي لإيقاا الا وط.
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 قاعدة التثليث / القاعدة الذهبية في التصوير

لرو ففي الصورة في إمردى أثرلاث الصرورة، "المامة" ج اء المحتواة و ا و اعدة التثليث تبص على و و

  سمبا الصورة إلى ثلاثة أثلاث فسوا يقر كرل جر ء مرن محتويراا الصرورة فري إمردى ا ثرلاث. أميانراً

لقاعرردة التثليررث. امتررواء  100فرري  100يتعررير علررى المصررور التقرراط وررورة تكررون محتوياتاررا م ابقررة 

قر تقريبا في إمدى ا ثلاث تكون أي ا مرضية. فقد لا ت ب   اعردة التثليرث فري الصورة على مكوناا ت

 كل وورة.

ربما تكون  اعدة التثليث هي أكثر  واعد التكوين شارة و انتشارا .. و لكن دعونا نلقي م يد من ال وء 

 علياا.

ن تجعل الكادر أو هبا  خ أ شائر يقر فيه كثير من المصورين المبتدئين و هو " التوميو " بمعبى أ

 الادا المراد تصويره في مبتصا الصورة تماما!

 اعدة التثليث أو الثلث و الثلثين كما يسمياا البع  إمدى  واعد التي تست ير الاعتماد علياا لكي تلتقو 

 وورة جيابة و متواانة.

أ ساي طولية و  عبد التقاط الصورة  م بتقسيماا في مايلتك كما هو موضح بالصورة السابقة .. ثلاثة

 خ وط .. اثبان بال ول و اثبان بالعرض ..  4ثلاثة أ ساي عرضية .. موا يبتج لك 

 تتقاطر هيه الا وط مر بع اا في أربعة نقاط كما هو موضح بالصورة ..

 

 ( يوضح  اعدة التثليث أو الثلث1شكل ر م )
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 ةدرجة ثالث  –أخصائي تدريب 

ل العبصر ا مامي في وورتك هيه البقاط هي مراك  جيل و  وة في الصورة .. ماول دائما أن تجع
 يقر على وامدة من هيه البقاط

  -: لاحظ الأمثلة التالية 
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 أي ا باصوص أ ساي الصورة نفساا

كما تلامظ أن  اعدة التثليث تقسم لك الصورة إلى ثلاثة أج اء طولية و ثلاثة أج اء عرضية , و هبا 

ة .. مثلا لو أنك تلتقو وورة للبحر و السماء .. تست ير امتاداي  اعدة التثليث لتواير عباور الصور

تست ير تجعل البحر يحتل الثلث ا مفل من الصورة و السماء تحتل الثلثين العلويين , أو تجعل البحر 

 يأتي في ثلثي الصورة و السماء في الثلث ا خير

 

 قاعدة التثليث و تصوير البورترية

لقوة في الصورة , فحاول دائما أن تجعل عين الشاص عين الشاص اليي تقوي بتصويره من مراك  ا
  تقر على إمدى نقاط تثليث الصورة
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 ةدرجة ثالث  –أخصائي تدريب 

 اعدة التثليث ليست هي القاعدة الوميدة ل بو التكوين و تواير عباور الصورة بشركل متر ن , هبرا   

 كثرر  واعد أخررى , و لكرن كمرا عرضربا فري بدايرة هريه المقالرة ..  اعردة التثليرث هري ا كثرر شرارة و ا

  ملائمة لمعظم تروا التصوير.

لامظ أن  اعدة التثليث هري  اعردة و بالترالي لارا شرواذ .. فابرا  مرالاا يكرون مرن ا ف رل كسرر  اعردة 

التثليث فياا , مثلا التصوير المعماري يكون من ا ف رل التومريو للحصرول علرى أبعراد متماثلرة أو عبرد 

. أنرت ومرد  مرن يقررر مترى تكسرر  اعردة التثليرث عبردما الا ترال أكثر في تصوير الماكرو و ايرهرا .

 .تكتسب الابرة اللاامة
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 ةدرجة ثالث  –أخصائي تدريب 

  : (للإطلاع فقط) الطرق الخاصة في الإضاءة

نحن نسعى لتقليد تأثيراا إضاءة موجودة في ال بيعرة. ففري المبراتر الاارجيرة لا تارر  تلرك الترأثيراا 

داخلية هي نور الباار أو ضوء الشم  نااراً، عن ضوء الشم  نااراً وضوء القمر ليلًا.وفي المباتر ال

 ونور المصابيح الكاربائية أو ايرها ليلًا. 

 تعريف الأنوار المختلفة بحسب وضعها واستعمالها في التصوير:

 :key lightالإضاءة الأمامية الرئيسية  (1

للإضاءة. ويستادي أي البور اليي يلقي الظلال ا مامية، ويتمي  على ما عداه، ويع ي الاتجاه الرئيسي 

في إضاءة فرد وامد أو مجموعة أشااص، والسرض مبه هو التأكرد مرن أن كرل مر ح يظارر فري مجرال 

 العدمة يباله شيء من ال وء.

 :Back lightingالإضاءة الخلفية  (2

وتكون خلا الموضوو تماماً واالبراً مرا يكرون وضرر ال روء علويراً وأميانراً يوضرر مباف راً جرداً علرى 

 ا رض.

 :Topflightور العلوي الن (3

 ويكون فوق الموضوو موجااً إلى ا مفل .

 : Front lightالنور الأمامي  (4

 هو البور اليي يكون اتجاهه مثل اتجاه الكاميرا، أي موجه موااياً لمحور العدمة ونحو الموضوو.

 : Side lightالإضاءة الجانبية  (5

أي إلرى أمرفل الموضروو، أو يسراره، المارم أنره  يكون ال وء عن يمين، ولايام إذا كان متجااً إلرى أعلرى

على أمد جانبي الموضوو، في ل  عليه نور جانبي،  والبور الجانبي يساعد علرى إبرراا امرتدارة الوجره 

 وتظليله مما ي يد الصورة رونقاً .

 : Filling lightإضاءة ملء الظلال  (6

ن الظرلال  اتمرة كثيرراً بالبسربة للأجر اء وهي تع ي ضوءاً مبدداً لا يلقي تلالًا، وتسرتادي عبردما تررى أ

 الم يئة. فيبقص تباين الإضاءة بين البور والظل .
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 : Background lightإضاءة المنظر الخلفي )إضاءة الديكور( 

وهى الإضاءة التي يتم إمقاطاا على الديكور في المشاد، ويوضر المصرور خلرا الموضروو مرواء مرن  

 يمين أو يسار .

 : Eye lightنور العينيين  (7

ويستادي لإتاار بري  في عيون الممثلين، وهو لا يكاد يؤثر في الإضاءة العامة للموضوو ، و لا يظار 

 أثره إلا في مواد العيون وعادة يكون في مستوى العيبين . وله أهمية كبيرة في اللق اا القريبة.

 : Clothes lightإضاءة الملابس  (8

ة ال وء على الملاب  إذا كانت اامقة،  ويحسن أن يكرون فري نفر  وهو البور اليي يستادي ل يادة كمي

الجانب اليي به البور ا مامي متى نحافظ للمبظرر علرى ومردة اتجراه الإنرارة، فتبردو الصرورة أكثرر  روة 

وتأثيرا وأ رل لل بيعة. ويجب أن نحاذر مرن مرقوط جر ء مرن ال روء الصرادر مرن نرور الملابر  علرى 

 الوجه.

 :     )ية )المؤثراتالإضاءة التأثير (9

 شبكة الموامير الثابتة المتوااية. :أولاا

 نظاي العوارض والممراا. :ثانياا

 شبكة الروافر. :ثالثاا

 البيرمك.-نظاي البق ة المفردة التلسكوبي :رابعاا

الارارجي من هبا لابرد أن نركر  أكثرر علري الإضراءاا داخرل  اعراا التردريب أو أثبراء التردريب الحقلري 

التدريبية يتم تبفييها إما في  اعاا تدريبية مسلقة أو في موا ر العمل وفي أالب  نلامظ أنا أالب البرامج

 ا و اا تكون أثباء فترة الباار )أثباء ضوء الشم (.
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 ةدرجة ثالث  –أخصائي تدريب 

 ملاحظات أساسية لابد من مراعاتها لإعداد إضاءة جيدة لتوثيق برنامج تدريبي فوتوغرافياا :

 دريب جيداً بالإضاءة العلوية.جا   اعاا الت -

 جا  القاعاا جيداً بستائر مانعة لل وء متي لا تؤثر علي التصوير. -

 في اتجاه مباشر للإضاءة. الكاميرالا تجعل  -

بالبسرربة للترردريب الحقلرري فرري موا ررر العمررل لا تجعررل ضرروء الشررم  خلررا المترردربين المررراد  -

 تصويرهم. 

 التدريبية :أخلاقيات التوثيق الفوتوغرافي للبرامج 

 اتباو تعليماا السلامة المابية الااوة بمو ر التصوير. .1

 تس ية الحدث من كل جوانبه دون البظر لمشاكل العمل أو المشاكل الشاصية. .2

 عدي الامتفاظ ببساة من الصور علي ا جا ة الشاصية. .3

 عدي إمتسلال الصور بشكل شاصي في اير أاراض العمل. .4

 (. -فترة الامترامة -وير المشاركين أثباء البريك عدي اختراق الاصووية )عدي تص .5

 عدي تصوير المشاركين بشكل فردي إلا أثباء العرض أو المشاركة. .6

 التركي  علي ا مداث والفعالياا. .7

 التركي  علي الإيجابياا وإبرااها. .8

 اتباو القواعد والبروتوكولاا الرئامية والحكومية. .9

 والعالمية.الإلت اي بالقواعد والمواثي  المحلية  .10

 الالت اي بالعاداا والتقاليد في البلدان الماتلفة. .11

 امتفاظ الشركة بالملكية الفكرية للصور. .12
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 : )للإطلاع فقط(  معايير اختيار الصورة الجيدة

 وترتكز معايير اختيار الصورة الجيدة على عدة محاور هي : 

ومحور شكل الصورة ، والمحور  محور المحتوى ، ومحور مسامة الصورة ، ثم محور   ر الصورة ،

 ا خير اليي يتمثل في التعلي  المكتول المصامب للصورة .

ويمكن تحقيقه إلى أ صى درجة فري الصرورة الااليرة مرن ا شرااص فارو يشرير إلرى الصرورة ذاا القريم 

 الدلالية, ولتحق  هيه الصور جيل انتباه القارئ وإثارة اهتمامه بالمحتوى . 

 . الحيوية: 1

ير إلى الصرورة المفعمرة بالحيراة والحركرة وبالترالي فاري تشرير إلرى الصرورة الصرحفية الحقيقيرة  ن وتش

 الصحافة بوجه عاي تعك  ماتلا أوجه البشاط الإنساني .

 . التلقائية:2

وتشير إلى الصورة الفجائية التي التق ارا فري ترروا ايرر عاديرة أي ايرر متو عرة مرن  برل ا شرااص 

 ة أي الصورة التي لا يبظر أوحاباا إلى العدمة .الظاهرين في الصور

 . الصلة الوثيقة بالموضوع: 3

أن تكون الصورة على علا ة وثيقة وواضحة بالحدث اليي يكتب عبه البص الصحفي ويمكرن وورفه أو 

 شرمه بفاعلية أكبر .

 . الجانب الإنساني:4

جريل أكبرر عردد مرن القرراء ، فرإن و رر فالاهتماي بالجانب الإنساني ي يد مرن  يمرة الصرورة ويرؤدي إلرى 

مادث تصادي مثلًا والتق ت وورة السيارة ومدها كانت  ليلرة ا هميرة ، أمرا إذا كانرت الصرورة للسريارة 

وهي مقلوبة أو معلقة مكان خ ر أو على وشك السقوط في نار أو مكان مباف  فإناا تكون أكثر أهمية 

مة هيه الصورة إذا و ا بجوارها رجل الشرطة ومعه أمد لقوة تعبيرها عن المأماة ، ولكن تت اعا  ي

ضحايا الحادث و د ربو ذراعه أو ضمد جرمه ، فإناا تأتي اللمسة الإنسرانية فري الصرورة فتحولارا إلرى 

شيء عظيم القيمة  وي الدلالة يحر  مشاعر القارئ ويعمل على إثارة اهتمامره ممرا يظارر ويؤكرد علرى 

 الجانب الإنساني .
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 نب الفني: . الجا5

فالصورة الصحفية الصالحة للبشر يجب أن تتوفر فياا بع  المواوفاا الفبية ، د يقة المعالم ، واضحة 

 التفاويل ،  ابلة لل بر وأن يكون م حاا لامعاً وتمتاا بالتباين بين تلالاا .

 التعليق المكتوب المصاحب للصورة: 

نفساا فإن المتلقي يحترا  فري أالرب ا مروال مرين  على الرام من القول الشائر بأن الصورة تتحدث عن

ي الر وورة إلى تعلي  بسيو ييسر فاماا ، ليا يببسي تعريا كل وورة مرواء شاصرية أو موضروعية 

 متى لو كان الشاص مشاوراً جداً . 

وكيلك الصورة الإخبارية هي ا خرى بحاجة إلى تعلي  يوضح بع  جوانباا أو يلفت نظر التلقري إلرى 

 ما . عبصر

 لذا فلابد من تعليق بسيط لأي صورة يتم التقاطها في البرامج التدريبية.
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 الفصل الثاني

أساسيات التصوير 

 بالموبايل
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 مقدمة :

 بجككوة  وأصكحت  الجميك   لكى  يوجكوة  الذكيك  الهواتكك  ككميياا  لكك  احتاافيك  ككميياا  الجميك  يملك 

 فقك  المهمك   لهكذ  الإيكمنيكم  تملك  يفهك عليهكم بملاعتمكمة احتاافيك  صكو  التقكم  يكت  لا لممذا إذن يمتمز 

 .الأيا وانتهى بملموبميل التصويا اسمسيم  بمتحمع

 اتحمعهم؟ يمك  وكي  بملموبميل التصويا أسمسيم  هي يم

  الاعتحم ؟ بعي  أخذهم يجب التي الأه  الملاحظم  هي ويم 

 الاحتاافي ؟ لصو ا إلى للوصول تتولهم عملي  بجوة  تكون أن الذكي الهمت  لصو   يمك  وكي 

 .... التملي  الأيو  خلال ي  فق  بسي  الأيا إن
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 أساسيات التصوير بالموبايل

 -إرشادات هامة لإنتاج صورة جيدة بإستخدام كاميرا التليفون المحمول "الموبايل" :

 

 تعرف علي إمكانيات موبايلك. -1

كميياا الهمت  الكذكي تقكىا الكريكا يك  الميكلا  التكي  •

علكككى الصكككو  المرمليككك  بم تلككك  تضكككم  التصكككول 

التكككملا  والأنكككواع والأوذكككم   لكككذا عليككك  الحتككك  

واستكشمف همتف  الكذكي والتبحيقكم  المتكوفا  لكىي  

 وإيكمنيم  الكميياا ال مص  ب   وي  أه  الميلا :

وهي ييكل  تسكمب بملتقكم  صكو    صورة البانوراما: •

ذا  حجكك  أكحككا بتيكك  تصككو  المشككهى يكك  حولكك  

 .360ْبلاوي  

وهككي تمك كك  يكك   التعرررف علررى الوجرروي وتصررفيت ا: •

التقم  الصو  لأش مص وجعكل وجكوهه  تحكىو أكركا 

 صفمء وإشااق.

أي إيكمنيك  التقكم  التاككم   تسريع التقاط الصورة: •

السايع  بكىون تشكو  الصكو   وبملىذك  ذاتهكم للصكو  

 العمةي .

ككك  يمك هككم يعافكك  انتفككمل وهككذ  الميككل  تعتمككى علككى حسمسككم  حا الالتقرراط عنررد تحريررك ال ررات  : •

 الهمت  ي  يكمنه وأخذ صو   ع ىهم بىون التمج  للضغ  على الل .

  …ويم ت  بعك  الوذك  بكي  الضكغ  علكى ز  الالتقكم  وبكي  لتبك  التقكم  الصكو   المؤقت: •

 )إكتشف بنفسك!(والعديد من الم ايا الآخري 
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 : استخدام تطبيقات التصوير المختلفة -٢

الككميياا  فكي الهواتك   على الاغ  يك  أن •

الذكي  يمتمز  ي  حي  الجوة  إلا أن بعك  

التبحيق الافتااضي  للكميياا  تفتقا للقكى   

على التتك  بهذ  الميلا   لذا يجب تجايب 

تبحيقم  ي تلف  تم ت  المليى ي  الميكلا  

وتمك   ي  الكتتك  بمكم يقىيكه همتفك  بشككل 

م  فهككي كريككا  أفضككل  وعكك  هككذ  التبحيقكك

)شرار  تجاربرك مرع  وفا  بشكل يجكمنيويت

زملائرررررررك وإنصرررررررح م برررررررالتطبيق الرررررررذي 

 تستخدمه(

 

 التأكد من سلامة ونظافة كل من العدسة والشاشة -3

: 

إن عىس  وشمش  الهوات  الذكي  يرملي  تمميًكم  •

لالتقم  الصكو  ولكك  هكذ  الهواتك  ةا مًكم يكم 

تتواجى بي  أغااض أخا  في التقيح  أو فكي 

  أو ةا مًم يم يت  حمل الهمت  جيوب المعم  

الذكي بمليى أو العمل عليه  وهذا كله يمك  أن 

يعاضككه لتككواة  ذككى تسككحب الأذ  أو الغحككم  

والأوسككككككككككككككككككم  للهككككككككككككككككككمت  بشكككككككككككككككككككل 

والشمشككك  بشككككل خكككمص بمكككم  وللعىسككك  عكككما

و  ي فككك  يككك  ذكككى تهم علكككى التقكككم  الصككك

  الجيى   لذا يجب ت ظيفهم بمستهم بقبع  ي  القب  ال مع  وحممي  الهمت  بشكل كميل.

https://www.magltk.com/digital-camera-lenses/
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 استخدام الالتقاط المتعدد في حالة الحركة -٤

هككذ  الميككل  سككتتيب لكك  التصككول علككى أكرككا  •

يكك  نسكك   لكك فر الصككو   لتفككمةي أي خبكك  

غيكككا يقصكككوة يمكككك  أن يصكككيب الصكككو   

تصول عليهكم ني  إعمة  الويفسىهم بىون إيكم

)استخدم هذي الخاصية في حالرة  يا  أخا 

قيرررام المررردرب أو المتررردربين بحركرررة أثنررراء 

 (وذلك لتلافي اهتزاز الصور التدريب

 

 "التقريب" الزوم إستخدام تجنب -٥

 علكى يعتمكى لأنكه اللوا  است ىاا يفضل لا •

 الصككككو   يكككك  صككككغيا جككككلء اذتصككككمص

 يكم وهكذا تقايحهكم  ولكير وتكحياهكم الكميل 

 ضككيمع حسككمب علككى عمككلي الككلوا يجعككل

 علككى التصككول ثكك  ويكك  الىذكك  يكك  الكريككا

 تقترررررب أن عليررررك لررررذا) يشككككوه  صككككو  

برردلاً  مرن العنصررر المرراد تصرويري ب اتفرك

 .(من استخدام الزوم

 

 تجنب استخدام الفلاش بغير موضعه -٦

خحككااء التصككويا والككذي  يوصككون بمتحككمع  •

أسمسيم  التصويا بملموبميكل لا ي تصكون 

بملإكركككككم  يككككك  اسكككككت ىاا الفكككككلا  بغيكككككا 

يوضككعه فككي الكككميياا  الاحتاافيكك  وهككذ  

  التوصي  أه  ي  الهوات  الذكي .
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 استخدام أكبر دقة وحجم للصورة -٧

فككي التبحيككق الافتااضككي للكككميياا أو فككي  •

التبحيقككم  التككي تكك  التصككول عليهككم  أول 

وأه  اسمسيم  التصكويا بملموبميكل والتكي 

 هككككم هككككي الككككىخول إلككككى عليكككك  الت كككككى ي

إعككىاةا  الكككميياا أو التبحيككق والوصككول 

إلى جوة  الصو   أو يواصفم  الصكو   

واختيككم  أكحككا حجكك  لهككم يكك  أكحككا سككع  

ت لي يكك  بملإضككمف  إلككى أعلككى ةذكك   هكككذا 

يمك كك  أن تضككم  التصككول علككى أذصككى 

  الميلا  التي يقىيهم همتف  وأجمل الصو  التي يمك  التقم هم به.

 

 تعديل الصور إن تطلب الأمر بإستخدام التطبيقات المتخصصةال -٨

إجااء التعىيلا  على الصكو   تصكفيتهم   •

تقويككك  الألكككوان  جعلهكككم أجمكككل  وغياهكككم 

الكريا ي  الميلا  يمكك  لميكا أن يككون 

صعب بمل سح  للكميياا  الاحتاافي  لأن  

للقيكما  جهكمز كمحيكوتاع ىهم سكتتتم  إلكى 

فه كم  العىيكى لهكمت  بهذ  المهمك  أيكم يك  ا

التككي تمك كك  يكك  يعملجكك  التبحيقككم   يكك 

  ويكك  أهكك  الأسككاا  التككي يتحعهككم الصككو 

خحااء التصويا هي أنه  يقويون بتمايكا 

الصو   في عى  تبحيقكم  للتصكول علكى 

 )إكتش  هذي التطبيقات بنفسك وقم بتبادل المعرفة مع زملائك(.. نتيج  يرملي 
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 حتاجه هاتفك وتثبيت اليد تمامًا.التعرف إلى الوقت الذي ي -٩

بعيىاً ع  ييل  المؤذك  توجكى يكى  زي يك   •

ذصككيا  تفصككل بككي  لتظكك  الضككغ  علككى 

ز  الالتقكككككم  ولتظككككك  التصكككككول علكككككى 

الصكككو   وحفظهكككم  هكككذ  المكككى  لا يمكككك  

التغلكككب عليهكككم  لكككذا ككككل يكككم عليككك  هكككو 

التعككاف إليهككم والتعككوة بتيكك  تككتمك  يكك  

 ككككب ترحيكككك  الصككككو   خلالهككككم حتككككى تتج

التشكككو  ال كككمت، ع هكككم  فكككي المقمبكككل يجكككب 

التككى ب علككى ترحيكك  اليككى بشكككل عككما أو 

)ملحوظررة : تزيررد مرردة إلتقرراط الصررورة عنررد اسررتخدام  الأ جككل ثلاثككي التميككل الاعتمككمة علككى 

 الفلاش(.

  

 تعلم كي  تضبط الدرجات اللونية -١٠

أفضل  ايق  لتعل  كيفي  ضح  الكى جم   •

 كك  التغيككا فككي   فيمكالتجابكك اللونيكك  هككي 

الإعككىاةا  ويلاحظكك  الفككاق الككذي تقىيككه 

كل ي هم  ي  تكاا  الأيا سكوف تكتسكب 

ال حككككككا  اللازيكككككك  لتتككككككىة الإعككككككىاةا  

 المبلوب  بساع .

 

حرراول التقرراط الصررور بالكرراميرا الخلفيررة فرري  -١١

 أغلب الأحيان

غملحكًككم يكككم تككككون ةذككك  الككككميياا ال لفيككك   •

للهككككمت  الككككذكي أعلككككى يكككك  الكككككميياا  

يميي   ولتت كى ي  ذل  يمك   الا لاع الأ

علكككى يواصكككفم  الهكككمت  والتكككي تككككون 
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يقىي  ي  الشاك  المص ع    وبعى تتىيكى الىذك  التكي تقكىيهم ككل الككميياا  عليك  الاعتمكمة علكى 

يمك كك  التضككتي  بككحع  الىذكك   وررورة مرريلفي الأعلككى  ففككي ال هميكك  إنهككم صككو   احتاافيكك  ليسكك 

ولحسرن الحرب بردأت ال واتر  الحديثرة باسرتخدام الدقرة ذات را للكراميرا الأماميرة للتصول عليهم  

  والخلفية.

 

 ”القاعدة الذهبية“استخدام قاعدة التثليث  -١٢

اةخل إلى إعىاةا  تبحيق الكميياا الذي  •

التكي  2×2تست ىيه وفعلّ خيم  الشكحك  

  لكك  خبككي  بشكككل أفقككي وخبككي  تصككم

بشكل  أسكي   وحكمفع علكى تفعيكل هكذ  

ال مصككككي  التككككي سككككتعمل علككككى جعككككل 

الصكككو  أفضكككل  فيجكككب علكككى الع صكككا 

 يوجككوةالأسمسككي فككي الصككو  أن يكككون 

 على أحى ال بو  بتي  يشغل ثلري الصو  ويجب تج ب التوس  في وضك  الع مصكا الا يسكي .

 ع علي قاعدة التثليث()قم بالرجوع إلي الفصل الأول للإطلا

 

 الصور خلفية من تأكد -١٣

تلعب خلفي  الصو   الىو  الأكرا أهمي   •

علكككى الكككاغ  يككك  أن ت ثياهكككم لا يظهكككا 

بشكككل واضككب إلا أنهككم الجككلء المسككؤول 

عكك  نجككم  أو فشككل اللقبكك   ويجككب أن 

 تتقق الأيو  التملي :

الانسكككجما يككك  الع صكككا الا يسكككي فكككي  •

 الصو  .

 ن بي  ال لفي  والع مصا الأسمسي .التحمي  في الألوا •

  أن تكون ياتح  بعيىاً ع  الازةحما والمحملغ  بتي  تكون يايت  للعي . •

https://www.magltk.com/taking-perfect-selfie/
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 الإضاءة الطبيعية هي الأفضل دائمًا -١٤

ضكككوء الشكككمر ةا مًكككم يكككم يعبكككي صكككو   •

نموذجي   لك  لير فكي ككل الأحيكمن ففكي 

فتا  الظهيا  تكون الشمر حمة  وهذا يم 

و  أيكككا غيكككا يكككايب يجعكككل التقكككم  الصككك

بمل سكككككح  للمصكككككو  أو الشككككك   أيكككككما 

العىسكككك   بي مككككم وذكككك  الغككككاوب أو فككككي 

ويجررب )  الإضرراءة مثاليررة الصككحم  تكككون

أن تكرررون الشرررم  خلفرررك ولررري  أمرررام 

العدسة إلا في حال كنت تستخدم أشرعت ا 

  .(يمكن أن تكون مقابل العدسة كتأثير جذاب عندها

 

 

https://www.magltk.com/light-photography-types/
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 الفصل الثالث

إعداد تقرير التوثيق 

 الفوتوغرافي
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 تقرير التوثيق الفوتوغرافي

Photo Documentation 

 : مقدمة

يتم تقييم الدورة التدريبية من خلال آلياا متعددة، ميث يتم تقييم الدورة مرن خرلال متابعرة تبفيري عباورر 

لمتدربين / مسئولي التدريب. و د العملية التدريبية بإمتاداي ومائل إما شفاية / كتابية من  بل المدرل / ا

تبين بإنه بالرام من تعدد طرق التقييم فإن هبا  بع  القصور في عملية التقييم، وليا فإن تصوير و ائر 

التدريب مبي بدايته ومتى ناايتره  رد مراعد فري معرفرة البترائج الحقيقيرة للتردريب، وبالتبعيرة تروفر إمكانيرة 

مرن  واعرد الجرودة فري العمليرة التدريبيرة "تسرجيل الفعاليراا"، ويعتبرر  تحسين العملية التدريبية. كمرا وأن

 التوثي  التصويري أمد أهم مفرداا عملية تسجيل الفعالياا.

 -أهمية التوثيق الفوتوغرافي للبرامج التدريبية :

 أمد ألياا تقييم أعمال العملية التدريبية )المدرل / المتدربين / ومائل التدريب / طرق التدريب( -

 مرجعية لت بي  برنامج / ميباريو الدورة التدريبية -

 أمد مكوناا تقرير إنجاا الدورة التدريبية -

 إمدى طرق ايادة نسبة تيكر المعلوماا والمعارا وا مداث -

 كيفية إعداد تقرير التوثيق الفوتوغرافي )تدريب عملي بمعمل الحاسب الآلي(

 )ملحقاا( محتويات تقرير التوثيق الفوتوغرافي : -أولاا :

 البيانات الأساسية للبرنامج التدريبي : •

امم البرنامج التدريبي / تاري  التبفيي / عدد أياي التدريب / أمم المدرل / عدد المتدربين / مكان 

 التبفيي.

 بيانات المشاركين. •

 صورة جماعية للمشاركين. •

 الأهداف التدريبية للبرنامج التدريبي. •

 الجدول الزمني للتدريب. •

 ط الأساسية في التدريب والعرض التقديمي.النقا •

 مشاركات المتدربين. •

 نقاط القوة ونقاط الضعف والتوصيات. •
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 تقرير التوثيق الفوتوغرافي خطوات إعداد  -ثانياا :

 )تدريب عملي( الصور وتصحيح الألوان والإضائةفرز  /1

 – Adobe Lightroomامج تتم عملية فرا الصور ومعالجتاا بامتاداي العديد من البرامج مثل برن

 وموا نتباول كيفية معالجة الصور بامتاداي برنامج الفوتوشول . Adobe Photoshopوبرنامج 

 

 ؟ يغير كل شيء والإضائة لماذا تصحيح الألوان

 .والإضائة وامدة من التقبياا ا مامية التي متحتا  إلى معرفتاا لمعالجة الصور هي تصحيح ا لوان

 -:والإضائة  وعة متبوعة من ا دواا لتسيير ا لوانمجموموا نتباول 

 

 أ/ معالجة إضاءة الصورة : اتبع الخطوات الآتية لمعالجة اضائة الصورة

  File>Open م بفتح الصورة علي برنامج الفوتوشول من  ائمة  -1
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  Image>Adjustments> Level م بالدخول علي  ائمة  -2

 

 موا تظار لك هيه الشاشة الجديدة  -3
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 Autoل بو ا لوان بشكل تلقائي اضسو علي ار  -4

 

 اتبر ال ريقة الآتيةل بو ا لوان بشكل يدوي  -5

 

الأسود يمثل الظل 

في الصورة 

 )تغميق الصورة(

يمثل  الرمادي

درجات المتوسطة ال

 في الصورة

الأبيض يمثل الدرجات 

الفاتحة في الصورة 

فتيح الصورة()ت  
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أساسيا

ت 

 ةدرجة ثالث  –أخصائي تدريب 

: اتبع الخطوات الآتية ( تحرير الالوان عن طريق التدرج اللوني والتشبع) ب/ معالجة ألوان الصورة

 Image>Adjustments> Hue/Saturation لمعالجة ألوان الصورة الصورة

 

 Brightness/Contrast الوضوح والتباين في الصورةتصحيح ج/ 

Image>Adjustments>Brightness/Contrast 

 

 )يفضل أن تقوم بهذه الخطوة في البداية( Shadow/Highlighمرتفتيح المناطق المعتمه بواسطة الأ /د

Image>Adjustments>Shadow/Highligh 

 

 التدرج

 التشبع

 السطوع

الاضاءه ودرجة الوضوح والسطوع  

 التباين
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أساسيا

ت 

 ةدرجة ثالث  –أخصائي تدريب 

 )تدريب عملي( المناسباقتصاص الصور لتحديد الجزء  /2

 

 

 )تدريب عملي( (Microsoft PowerPointالعرض التقديمي علي برنامج )بناء قالب  -3

 لبناء قالب العرض التقديمي. View>Slide Masterأ/ قم بالدخول علي قائمة 
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أساسيا
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 ةدرجة ثالث  –أخصائي تدريب 

 (Slide Master)ب/ سوف تفتح لك هذه النافذة 

 

 ب/ أدوات لرسم مخطط الشرائح

 

 

 

 

 

 

 

 

 

تطبيق ألوان / خطوط / تأثيرات معينة علي القالبج/   

  

  مساحة متعددة الاستخدامات لإدخال

  نص لإدخال

  صورة لإدخال

  رسم بياني لإدخال

 جدوللإدخال 

 الرسومات الذكيةلإدخال 

  صوتيات( –الميديا )أفلام  لإدخال

  Clip Artالرسومات  لإدخال

 الألواناختيار 

 الخطوطاختيار 

 التأثيراتاختيار 
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أساسيا

ت 

 ةدرجة ثالث  –أخصائي تدريب 

 

 4- استكمال اعداد تقرير التوثيق الفوتوغرافي وفقاا لمحتويات التقرير السابق ذكرها. )تدريب عملي(
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أساسيا

ت 

 ةدرجة ثالث  –أخصائي تدريب 

 إعداد المادة العلمية

 -تم إعداد المادة العلمية بواسطة :

 الاستاذ / محمد جمال زكي شعيرة  •

 رجي والتسوي  بشركة مياه الشرل بالقاهرةمدير إدارة التدريب الاا
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أساسيا

ت 

 ةدرجة ثالث  –أخصائي تدريب 

 

 المراجع

 –حقيبة التصوير الفوتوغرافي والإضاءة صادرة عن المؤسسة العامة للتدريب التقني والمهني  •

 المملكة العربية السعودية(.

 الموسوعة الحرة ويكيبيديا )التصوير الفوتوغرافي( •

https://ar.wikipedia.org/wiki/%D8%AA%D8%B5%D9%88%D9%8A%D8%B1_%D9%81%D9%88%D8%

AA%D9%88%D8%BA%D8%B1%D8%A7%D9%81%D9%8A 

 

 

https://ar.wikipedia.org/wiki/%D8%AA%D8%B5%D9%88%D9%8A%D8%B1_%D9%81%D9%88%D8%AA%D9%88%D8%BA%D8%B1%D8%A7%D9%81%D9%8A
https://ar.wikipedia.org/wiki/%D8%AA%D8%B5%D9%88%D9%8A%D8%B1_%D9%81%D9%88%D8%AA%D9%88%D8%BA%D8%B1%D8%A7%D9%81%D9%8A
https://ar.wikipedia.org/wiki/%D8%AA%D8%B5%D9%88%D9%8A%D8%B1_%D9%81%D9%88%D8%AA%D9%88%D8%BA%D8%B1%D8%A7%D9%81%D9%8A
https://ar.wikipedia.org/wiki/%D8%AA%D8%B5%D9%88%D9%8A%D8%B1_%D9%81%D9%88%D8%AA%D9%88%D8%BA%D8%B1%D8%A7%D9%81%D9%8A
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أساسيا
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 ةدرجة ثالث  –أخصائي تدريب 

 

 شاك  ييم  الشاب بملقمها  الكحا 

 

 


